Introduction

Completing Your Enrolment
My Birkbeck Profile
Fees, Financial Support and Payment Details
Moodle
School of Arts Location
Attendance Requirements
Programme Student Support
Student Representation
Start of Term for New Students

Term Dates

MA Creative and Critical Writing Staff Contact List

Core Course 1: Reading the Contemporary
(PT students: Autumn Term Year 1; FT students: Autumn Term Year 1)

Core Course: The Writing Workshop
(PT Students: Spring Term, Year 1; FT Students, Spring Year)


Core Module: Key Concepts in Cultural and Critical Studies 2 (ENHU004S7)
(PT Students: Autumn Term, Year 2; FT students: Autumn Term, Year 1)

Core Course: Dissertation

Assessment
Supervision 43
Summer Term Research Skills Classes 44
Dissertation Format Error! Bookmark not defined.
Optional Course: Summer Programme (ALL) Error! Bookmark not defined.

Assessment Information 47

- MA Assessment
- Grade-Related Criteria – Critical 48
- Grade-Related Criteria – Creative 49
- Plagiarism 52
- Collusion 54

Essay Guidelines and Advice: Coursework Submission, Return of Coursework and Late Submissions 55
College Assessment Policy 57
Style Guide 59

Support for Students 67

- Academic and Language Support Facilities for Postgraduate Students 69
- Student Support 71
- International Students 72

Study Resources 73

- Libraries 73
- Other Graduate Activities 83

Appendix A: Getting Started with Moodle 85

Appendix B: Common Awards Scheme Regulations and Policies 86

Appendix C: MA Dissertation Proposal Form 87

Published Online September 2019

This document is for reference only. Every effort was made to ensure that information was correct at time of online publication, but discrepancies may still occur due to the nature of this document. For current information and updates, always refer directly to the Birkbeck College website.
Introduction

When Birkbeck College was established in 1823, its principal mission was to provide education and training to working adults who earlier in life had lacked educational opportunity. Birkbeck now welcomes a diverse range of students, studying both full- and part-time at undergraduate and postgraduate level. A College of the University of London since 1920, Birkbeck is still highly committed to the concept of lifelong education, and especially within the world of work. Birkbeck and the other member colleges of the University of London have many research interests in common and share the same standards and degrees structures, but in one important respect Birkbeck is unique. Our mission is ‘to provide courses of study to meet the changing educational, cultural and training needs of adults who are engaged in earning their livelihood, and others who are able to benefit’ (Birkbeck College Charter).

Birkbeck College has built up special expertise in providing a stimulating, positive learning environment for adult, mature students. We award undergraduate degrees in a full range of disciplines, taught in full-time and part-time modes, and we have an unusually high proportion of students following taught Masters and MPhil/PhD courses.

Department
Welcome to the Department of English and Humanities in the School of Arts. You are joining a vibrant community of graduates, which includes over 200 MA and some 100 PhD students. We hope that you will feel at home in this intellectual community. This booklet contains the essential information about the MA Contemporary Literature programme.

The Department of English and Humanities occupies houses in Gordon Square which are associated with the members of the Bloomsbury Group. 46 Gordon Square was the family home of Virginia Woolf, her brothers and her sister, Vanessa, until the latter's marriage to the art critic Clive Bell in 1907. It was later occupied by the economist John Maynard Keynes.

Most School of English activities take place in 43 Gordon Square, with classes also held in Russell Square and in the Main Building on Malet Street (and occasionally in other University of London buildings). The Malet Street building is where the Library, computer rooms and the student bar (fifth floor of the extension) are situated. A snack bar is located on the ground floor of 43 Gordon Square. We are close to the bars and cafés of the University of London Union, the Institute of Education and the School of Oriental and African Studies: explore the area for the environment that suits you.

We aim to provide intellectual stimulus in a supportive environment. Some students find the transition to graduate work initially disorientating, but we have a lot of
experience in helping mature students with heavy commitments elsewhere successfully to manage their postgraduate studies. If you do have any difficulties, please talk to your module tutor, your personal tutor, or to the Programme Director.

**MA Creative and Critical Writing**

The MA in Creative and Critical Writing aims to provide students with blended learning in the interconnected fields of creative writing and critical thinking by combining both practice-based learning and specialism in contemporary literature, culture, and criticism, as well as the development of their own creative writing projects. This interdisciplinary Master’s degree explores critical methods and debates on experimental literature, media, popular culture, technology, and cultural development and aims to give students the opportunity to develop both their critical thinking skills as well as fiction and non-fiction writing skills. With creative writing modules in creative non-fiction; writing workshops in which students can work on fiction or non-fiction, and the dissertation with combines the creative and critical elements, the degree offers a well-rounded and stimulating set of encounters that will shape one another.

The programme aims to provide students with relevant experience suitable for a variety of career opportunities. For example, this MA will be relevant for those also interested in pursuing a career in writing and publishing and will provide students with a firm and competitive educational foundation that will support MPhil and PhD study in creative writing, or in critical subjects within English or Humanities.

Dr Katherine Angel  
Programme Director  
[ k.angel@bbk.ac.uk](mailto:k.angel@bbk.ac.uk)
Starting your Course

Completing Your Enrolment
After receiving an offer of a place on the programme, you need to enrol as soon as possible. Enrolment is completed via your My Birkbeck Profile (see information below). **You must complete your enrolment within the first 28 days of term** by setting up a payment plan, or making a contribution to your fees. By completing your enrolment you can gain access to your student profile and programme documents.

Please ensure you read your contract of enrolment. **Students who withdraw or take a break in their studies after the first two weeks will be liable for the full fees for that term. Click here to complete your enrolment via your My Birkbeck Profile.**

Your **My Birkbeck Profile** in conjunction with **Student Services** is your gateway to accessing student support at Birkbeck. Quick links to the most current information on a range of services including the Birkbeck Library, Moodle, Timetables, Computing and IT Support, Career Services, Learning Support, Disability and Dyslexia Support, Counselling Service and more are listed.

**My Birkbeck Profile**
**My Birkbeck Profile** is the online facility that allows Birkbeck students to manage their relationship with Birkbeck online. You can login to your My Birkbeck Profile to check and amend your contact details, order an ID card and keep track of your financial status and grades. You will use your My Birkbeck Profile to access your module and timetable information, Personal Tutor details and eRegister record of attendance. At exam time, you will also be able to access your personal examination timetable and your results once they are published.

It is essential to access your My Birkbeck Profile on a regular basis and keep your contact details up-to-date, to facilitate communication and access between yourself and the College. Email is the standard means of communication in the School of Arts.

Please go to [www.bbk.ac.uk/mbphome](http://www.bbk.ac.uk/mbphome) to login to your My Birkbeck Profile with your username and password. If you do not have your username and password, please contact ITS Reception in the main Malet Street building or by submitting an [ASK Query](http://www.bbk.ac.uk/mbphome).
Fees, Financial Support and Payment Details
College fees may be paid by many methods. Please click here to follow the link to the College website, for the most current information on fees and payment, and here for details on financial support. Whilst we have great sympathy with students who find difficulties in paying their fees, neither the programme director nor any of your tutors have the power to waive fees or sanction delays in payment. For advice and support in relation to paying your fees, please contact the College Income Office. The Income Office deals with all enquiries relating to payment of fees, including direct debit queries. Please communicate and negotiate with the College Fees Office directly if you have any fee-related queries.

Fees Policy 2019/2020
You are strongly encouraged to take a look at the Fees and Payments page on the website and read the current Fees Policy. Refer to these resources to answer questions such as What does fee liability mean? What is the last date I can enrol? and What should I do if I can't pay my fees? Students who fail to pay their fees may become ineligible to continue the course, unable to submit assessments or access their My Birkbeck Profile. Any student who has a debt to the College at the end of the year will not have their marks relayed to them.

Postgraduate Loans
Please see the Birkbeck website here for helpful information on applying for a postgraduate loan. You can also access the Postgraduate Loans and Enrolment: A Step-by-Step Guide for assistance enrolling onto your programme.

Moodle
Moodle (Birkbeck’s Virtual Learning Environment Platform) is an online student portal. You will be expected to upload and submit all assignment documents using Moodle throughout the duration of your study. You can also use Moodle to access interactive tutorials, lecture slides, reading lists and recorded lectures, career management resources and your personal student record.

It is recommended all students access Moodle Support for Students to become familiar with how to access Moodle and submit coursework online. Please Login to Moodle with your Birkbeck College username and password.

School of Arts Location
The School of Arts is housed at 43 Gordon Square, London WC1H 0PD, where you will find the administrative offices and individual staff offices. Teaching often takes place in our building, but your lectures may be held in any of the University of London or University College London buildings. Please login to your My Birkbeck Profile for access to your student timetable and links to maps of the buildings.
The Administrative Office
Please contact your Programme Administrator by phone or email to discuss any queries or to book an appointment. During term time, the Gordon Square entrance is staffed from 8.00am to 9.00pm, Monday to Friday and is open between 9.00am and 5.00pm on Saturdays (during term time only). Please access the student pigeonholes (located outside room G13) and deliver hardcopy coursework to the essay box by reception, during these times.

Attendance Requirements
Taking a degree course at Birkbeck requires a high level of commitment, and it is important that you attend seminars consistently. Regular attendance is a requirement of every course unit and you will be required to register your attendance each week. It is your responsibility to make sure you sign in using the e-register (see below) at every class you attend. It is accepted that through illness or exceptional pressure at home or at work you may have to miss occasional classes, but if you have to be absent from several classes, or you know that you are going to have difficulties in attending regularly, please inform the Programme Director. We do require notice of intended absence in writing (by email) to your module tutor and your Programme Administrator.

We are very sympathetic towards the problems encountered by students and we will do all that we can to help you through any difficulties you may have with your studies. Please do signal if you are having problems.

Registering your attendance with eRegisters
The eRegisters system allows students to keep track of and monitor their own attendance at teaching events. In Birkbeck teaching rooms, students will be expected to tap their Birkbeck student ID card onto a card reader at the beginning of each class. Please remember it is your responsibility to bring your Birkbeck ID card to class to monitor your attendance. This is especially important for those of you that are Tier 4 students. For further information on eRegisters please click here.

Programme Student Support
Any matters that students want to discuss that are directly related to the content of the MA should be discussed with the appropriate lecturer. Lecturers will let students know the time and place of their office hours, although you may wish to make an appointment. Email can be a convenient way to do this. Any other matters concerning the course should be taken up with your personal tutor. You will be informed of which member of the course team will act as your personal tutor at the beginning of term. You may discuss medical and pastoral problems in strict confidence.

Student Representation
Each year, we also ask for two student representatives from the MA to represent your
concerns to a staff-student committee. These representatives raise issues specific to your experience as an MA Contemporary student at Birkbeck. We'll ask you to nominate representatives during the autumn term.

**Start of Term for New Students**
The pre-term general Induction and reception for new English and Humanities students, will be held on **Thursday 26 September 2019 from 6pm**. An invitation to this event will be circulated by administration mid-September. Please click [here](#) for more information.

In the first term all full-time (FT) students and first year part-time (PT) students, will take [Core Course 1: Reading the Contemporary](#). This class will take place on **Monday at 6-9pm**, commencing on 30 September 2019.
## Term Dates

<table>
<thead>
<tr>
<th>Autumn Term</th>
<th>Spring Term</th>
<th>Summer Term</th>
</tr>
</thead>
<tbody>
<tr>
<td>Monday 30 September to Friday 13 December 2019</td>
<td>Monday 13 January 2020 to Friday 27 March 2020</td>
<td>Monday 27 April 2020 to Friday 10 July 2020</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Week 1</th>
<th>Week 2</th>
<th>Week 3</th>
<th>Week 4</th>
<th>Week 5</th>
<th>Week 6</th>
<th>Week 7</th>
<th>Week 8</th>
<th>Week 9</th>
<th>Week 10</th>
<th>Week 11</th>
</tr>
</thead>
<tbody>
<tr>
<td>13-Jan-20</td>
<td>20-Jan-20</td>
<td>27-Jan-20</td>
<td>3-Feb-20</td>
<td>10-Feb-20</td>
<td>17-Feb-20</td>
<td>24-Feb-20</td>
<td>2-Mar-20</td>
<td>9-Mar-20</td>
<td>16-Mar-20</td>
<td>23-Mar-20</td>
</tr>
</tbody>
</table>

Most services will be unavailable from 5pm on Friday 20 December 2019, re-opening at 9am on Wednesday 2 January 2019.

Most services will be unavailable from Wednesday 8 April to Wednesday 15 April inclusive. **Normal services will resume from 9am on Monday, 27 April 2020**

Most services will be unavailable on Monday 4 May & Monday 25 May 2020.

Please note: Week 6 each term is Reading Week – no classes are held during Reading Week unless specified by your module convenor.

Click [here](#) for full term dates and holiday closures.

Students are reminded that it is inadvisable to take holidays during term time.
# Programme Structure

The MA Creative and Critical Writing has five core modules and no optional modules. The MA is divided into two modules for creative writing and two modules for critical writing, and a dissertation that will demonstrate both creative and critical writing. The critical modules will run in the autumn and the creative modules will run in the spring.

## Part-time Study

<table>
<thead>
<tr>
<th>Year One</th>
<th>Autumn</th>
<th>Spring</th>
<th>Summer</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Core Module&lt;br&gt;Mondays: 6-9pm&lt;br&gt;AREN095S7&lt;br&gt;Reading the Contemporary</td>
<td>Core Module&lt;br&gt;Wednesdays: 6-8pm&lt;br&gt;ENHU039S7&lt;br&gt;The Writing Workshop</td>
<td>Summer Seminars</td>
</tr>
<tr>
<td></td>
<td>Year Two</td>
<td>Core Module&lt;br&gt;Thursdays: 6-7.30pm&lt;br&gt;ENHU004S7&lt;br&gt;Key Concepts in Cultural and Critical Studies II</td>
<td>Core Module&lt;br&gt;Tuesdays: 6-8pm&lt;br&gt;ENHU002S7&lt;br&gt;Creative Non-Fiction</td>
</tr>
</tbody>
</table>

## Full-time Study

<table>
<thead>
<tr>
<th>Year One</th>
<th>Autumn</th>
<th>Spring</th>
<th>Summer</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Core Module&lt;br&gt;Mondays: 6-9pm&lt;br&gt;AREN095S7&lt;br&gt;Reading the Contemporary</td>
<td>Core Module&lt;br&gt;Tuesdays: 6-8pm&lt;br&gt;ENHU002S7&lt;br&gt;Creative Non-Fiction</td>
<td>Core Module Dissertation&lt;br&gt;Research Skills sessions, summer seminars and supervisions&lt;br&gt;Submission of Dissertation: due 18 September 2020</td>
</tr>
<tr>
<td></td>
<td>Core Module&lt;br&gt;Thursdays: 6-7.30pm&lt;br&gt;ENHU004S7&lt;br&gt;Key Concepts in Cultural and Critical Studies II</td>
<td>Core Module&lt;br&gt;Wednesdays: 6-8pm&lt;br&gt;ENHU039S7&lt;br&gt;The Writing Workshop</td>
<td></td>
</tr>
</tbody>
</table>
Summer Term

The Summer Term features a programme of seminars and lectures that will help you work towards the dissertation, as well as offer insights into new areas and topics that may be of interest. They are broadly divided into Creative Writing provision and Research provision; you are welcome and encouraged to attend both.

CREATIVE PROVISION

Creative Writing Summer Lectures
Tuesday, 6.00-7.20pm
A weekly event, given by Birkbeck staff and/or external speakers. Some of these focus on craft elements (e.g. structuring the novel), while others focus on themes (the politics and ethics of reading/teaching writers with criminal prosecutions or offensive views; autofiction; diversity; archives), texts and authors (Kathy Acker, Kim Hyesoon, Valerie Solanas). Others involve in-conversation/panel events with authors (recently Sophie Mackintosh, Lara Pawson, and Amer Anwar have come to speak), and still others involve visitors from industry: publishers, book and magazine editors, literary agents, owners of small presses, and so on. This is a lively and stimulating series with ample opportunities for discussion.

RESEARCH PROVISION

Wednesday, 6.00-7.20pm
This provision addresses research methods useful for the dissertation, and also enables students to shape and then encounter extra theoretical and critical material in which they are interested.

In Week 1, students meet with MA module convenors across the MA programmes to generate topics and ideas to be taught in the Summer Seminars, in the second half of the Summer Term.

Weeks 2, 3, and 5: Research Skills Programme
The Research Skills Programme is a short series of seminars addressing research methods that will be useful for your dissertation. The Research Skills Programme is primarily for year FT and PT2 students who are working on the dissertation, but part time year 1 students are permitted to attend.

Weeks 7, 8, 9: Summer seminars
Wednesday, 6.00-7.20pm,
Topics chosen by consultation in Week 1.

ARTS WEEK
This takes place in Week Four. You can sample from a programme of events across the whole week, daytime and evening, featuring public lectures, performance, screenings, walking tours, craft workshops, organised and presented by Birkbeck staff, students, and external speakers.
Dissertation
A 15 000-word dissertation on any topic from the many areas covered by the MA in Creative and Critical Writing is written over the summer. Students meet with their supervisor for close consultation on their topic for three hour-long supervisions on mutually convenient dates. These must be concluded by the final day of the academic year (at the end of Summer Term Year 2 for PT students, and end of Summer Term Year 1 for FT students).
MA Creative and Critical Writing Staff Contact List

<table>
<thead>
<tr>
<th>Key Contacts</th>
<th>Room</th>
<th>Email</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Dr Katherine Angel</strong></td>
<td>319, 43 Gordon Square</td>
<td><a href="mailto:k.angel@bbk.ac.uk">k.angel@bbk.ac.uk</a></td>
</tr>
<tr>
<td>Programme Director</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Annmarie Shadie</strong></td>
<td>43 Gordon Sq</td>
<td><a href="mailto:englishandhumanities@bbk.ac.uk">englishandhumanities@bbk.ac.uk</a></td>
</tr>
<tr>
<td><strong>Teaching Staff on the MA Creative and Critical Programme</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Dr Grace Halden</strong></td>
<td>43 Gordon Square</td>
<td><a href="mailto:g.halden@bbk.ac.uk">g.halden@bbk.ac.uk</a></td>
</tr>
<tr>
<td><strong>Dr Sean O’Brien</strong></td>
<td>43 Gordon Square</td>
<td><a href="mailto:s.obrien@bbk.ac.uk">s.obrien@bbk.ac.uk</a></td>
</tr>
<tr>
<td><strong>Dr Martin Eve</strong></td>
<td>43 Gordon Square</td>
<td><a href="mailto:martin.eve@bbk.ac.uk">martin.eve@bbk.ac.uk</a></td>
</tr>
<tr>
<td><strong>Dr Anna Hartnell</strong></td>
<td>43 Gordon Square</td>
<td><a href="mailto:a.hartnell@bbk.ac.uk">a.hartnell@bbk.ac.uk</a></td>
</tr>
<tr>
<td><strong>Dr Mark Blacklock</strong></td>
<td>43 Gordon Square</td>
<td><a href="mailto:m.blacklock@bbk.ac.uk">m.blacklock@bbk.ac.uk</a></td>
</tr>
</tbody>
</table>

Above are the core teachers on the MA Contemporary programme. Teaching and dissertation supervisions are also provided by additional specialists in the Department of English & Humanities.

- Please check office hours with individual staff members. We ask you visit offices only when you have made an appointment. Please ring or email in advance. Staff members are available for tutorials at other times by appointment.
- Staffing is subject to change and listing in this handbook is not a guarantee that a specific staff member will be with the Department in the 2017-18 academic year.
- There is a research leave policy in the College, which means that all members of academic staff are entitled to one term’s research leave every three years. In addition, members of staff are regularly awarded externally funded research leave, by organisations such as the Leverhulme Trust and the Arts and Humanities Research Council. Therefore, not all academic staff will be present at all times. On such occasions the Department will arrange replacement cover and advise the affected students.
Core Course 1: Reading the Contemporary
(PT students: Autumn Term Year 1; FT students: Autumn Term Year 1)

Module Convenor: Dr Sean O’Brien
Module Lecturers: Dr Sean O’Brien (SO), Dr Katherine Angel (KA), Dr Joe Brooker (JB), Prof Martin Eve (ME), Dr Caroline Edwards (CE)
Module Code: AREN095S7
Module Level: 7
Timetable: Autumn Term, Mondays 6.00pm – 9.00pm

All sessions involve a lecture (6-7.20) followed by a seminar (7.40-9) with the exception of Week 11, during which the first session (6-7.20) will be taught as a closing lecture and the second session (7.40-9) will consist of a student-led workshop on Reseaching the Contemporary.

Module Description

This course introduces students to a range of contemporary literary, cinematic, visual and theoretical works published since 2000, tracing some of the major developments in contemporary literatures at the beginning of the twenty-first century. Taking in poetry, film, memoir, journalism, television, the novel, the graphic novel, science fiction and digital culture, this course explores the meanings and characteristics of the ‘contemporary’ via a focus on categories like trauma, crisis, memory, futurity, and the digital – terms that have been major preoccupations of cultural production in the last two decades.

Aims and objectives:

- To provide a comprehensive grounding in some of the key trends and texts in the field of contemporary literature and culture, with a special focus on the post-2000 period.
- To engage students in debates about the conceptualization of the contemporary, and to equip them with the appropriate vocabulary and critical paradigms.
- To identify and engage with the key features and characteristics of new forms of writing that have emerged as a result of new technologies.
- To develop a multidisciplinary approach to the study of contemporary literature and culture.
The assessed essay is due on the first day of the spring term.

Texts and media that you will need to purchase:
- *Beasts of the Southern Wild*, dir. Benh Zeitlin (2012) [Film]
- *The Expanse*, Season 1, Episode 1, ‘Dulcinea’ [TV]
- Ashley McKenzie, *Werewolf* (2016) [Film]

**Please note:** all core reading material that is *not* listed above – these will usually be short texts, i.e. essays, poems, short stories etc. – will be made available either electronically via Moodle (Birkbeck’s virtual learning environment) or via a handout given out in advance of the relevant class.

All recommended secondary reading is available via the e-journal databases (Project Muse and JSTOR), in Birkbeck Library or Senate House Library; you will also be able to find copies of all texts in the British Library.

**Introductory reading on contemporary literature and cultural theory:**


Ann Kenniston and Jeanne Follansbee Quinn (eds), *Literature After 9/11* (New York: Routledge, 2010)

Roger Luckhurst, *The Trauma Question* (London: Routledge, 2008)

Roger Luckhurst and Peter Marks (eds), *Literature and the Contemporary* (London: Longman, 1999)


Seminar Schedule

Week 1 | When was the Contemporary? (SO)
This session introduces the module by opening a debate about the nature of the contemporary: is it primarily a conceptual or a periodizing term? What is the contemporary ‘now’? We’ll being with a lecture covering key critical writings on the notoriously slippery notion of the contemporary, drawing out its overlapping theoretical, cultural, political and environmental implications.

Through a discussion of *Beasts of the Southern Wild*, this introductory class will also consider the idea that the contemporary world is in some ways ‘post-American’.

**Essential viewing / reading:**
- Giorgio Agamben, ‘What is the Contemporary?’ in *What is an Apparatus? And other Essays* (2009)

Week 2 | Retro Action (JB)
The contemporary seems to be about the new. But contemporary cultural production also involves revisiting the past. How does the aesthetic reconstruction of the past contribute to the cultural-temporal mosaic of the contemporary? Are we attracted to the glamour of the past, nostalgic for its certainties, or keen to use it to interrogate the present? How is the past manipulated and remade by the lenses and styles of our contemporary moment?

**Essential reading:**

The lecture will also refer to the TV series *Mad Men* (2007-2015), on the 1960s.

**Recommended additional/comparative texts:**
- 1980s neo-1950s movies: *Back To The Future, Peggy Sue Got Married, Absolute Beginners*
- post-2000 neo-1980s movies: *Donnie Darko, 13 Going on 30, This Is England*
- Retro TV: *Life on Mars* and *Ashes To Ashes*

**Background reading:**
- Simon Reynolds, *Retromania* (London: Faber, 2011): the fullest work to date in this field: if you’re interested in Retro, read this

**Week 3 | World-System Failure (SO)**
A decade after the 2008 financial crisis, the future of the capitalist world-system remains uncertain, as nation states retreat from international partnerships and the neoliberal consensus appears to be on the wane. The capitalist world-system is also undergoing a profound transition at the very moment that it is increasingly butting up against ecological limits. This session will examine issues of hegemonic transition, climate crisis and economic stagnation in the SYFY television series *The Expanse*. How does the series mobilize the speculative capacities of science fiction to explore
the prospects for further expansion of the capitalist world-system? Students should familiarize themselves with the pilot episode, ‘Dulcinea’.

**Essential reading:**
- Mark Fergus and Hawk Ostby, ‘Dulcinea,’ *The Expanse* (SYFY and Alcon Entertainment, 2015–).

**Background reading:**
Week 4 | The World Without Us: Apocalypse and the Anthropocene (CE)

What will the world look like without us? Nikolaus Geyrhalter’s post-apocalyptic art film Homo Sapiens blurs the boundaries between photography installation and narrative cinema, taking us on an uncanny tour of the planet after humans have mysteriously disappeared. In this session we will consider how Geyrhalter’s film responds to important issues raised by environmental discourse in the humanities (or the “environmental humanities”), since the environmental movement of the 1960s-70s. At a time of ongoing crisis in the 21st century, as visions of looming ecocatastrophe proliferate in novels, films and artworks, Geyrhalter’s compelling thought experiment helps us think through the competing temporal scales (anthropocentric, geological, capitalist, post-anthropocentric, utopian) necessary to confronting the climate crisis and its existential threat to human habitation as we know it.

**Essential viewing:**
- Nikolaus Geyrhalter, *Homo Sapiens* (2016) [copies available in the library]

**Essential reading:**

**Background reading:**
- Ursula K. Heise, Jon Christensen, Michelle Niemann (eds), *The Routledge Companion to the Environmental Humanities* (New York Routledge, 2016)
Week 5 | Posthumanism and Gender in the Feminist Manifesto 2.0 (KA)
What does it mean to be human in the 21st Century? How can we define the human and the ‘non human’, and how does this relate to changing ideas about gender? This session will examine an important contemporary feminist manifesto, the *Xenofeminism: A Politics for Alienation*, written by the Laboria Cuboniks collective. This manifesto proposes that nothing “should be accepted as fixed, permanent, or given—neither material conditions nor social forms”. Embracing technological intervention and wild imaginative relationships to the future, it proposes an anti-naturalist, post-gender, trans-inclusive feminist utopia. We will examine this text, and explore its relationship to other important, ambitious, ecstatic, and uncompromising manifestos such as Valerie Solanas’s *SCUM Manifesto* of 1967 and Donna Haraway’s *Cyborg Manifesto*.

Essential reading:
- *Xenofeminism: A Politics for Alienation*: [https://www.laboriacuboniks.net/](https://www.laboriacuboniks.net/)

Background reading:
- Helen Hester, *Xenofeminism* (Polity, 2018)

Week 6 | Reading Week – no class

Week 7 | The Afterlives of Slavery (SO)
This session reads Claudia Rankine’s *Citizen: An American Lyric* in the context of systemic antiblack violence, the rise of Black Lives Matter and the Movement for Black Lives, and new theories of racialization, Blackness and anti-Black racism. We will focus in particular on the way in which *Citizen* combines genres of prose, poetry and visual imagery in its depictions of police killings of African Americans and racist micro-aggressions. This session will also refer to recent work in Black Studies on the legacies of slavery and the concept of social death in our discussion of Rankine’s genre-bending bestseller.

Essential Reading:
• Claudia Rankine, *Citizen: An American Lyric* (Minneapolis: Graywolf, 2014).

**Background Reading:**
• Orlando Patterson, *Slavery and Social Death: A Comparative Study* (Cambridge, MA: Harvard University Press, 1982).

**Week 8 | Reading Digitally (ME)**
In the digital age, it is frequent to consider the possibilities of fictional form. New e-literatures avail themselves of digital affordances to yield fresh narrative potentials. Of equal concern, though, and the focus of this week’s session is how reading is
being changed by digital technologies. Here we will consider new kinds of methodological experiments in reading in the disciplinary field known as “digital humanities”.

**Essential reading:**

**Background reading:**
- Franco Moretti, *Distant Reading* (London: Verso, 2013)
- Susa Schreibman, Raymond George Siemens, and John Unsworth, eds. *A New Companion to Digital Humanities* (Chichester: John Wiley & Sons Inc, 2016.)

**Week 9 | Networks Beyond the Nation (SO)**
This session will explore the meanings of transnationalism, postcoloniality and globalization in the contemporary period, particularly as they relate to the vectors of race and class. It will map these categories via a reflection on the British Indian novelist Rana Dasgupta’s debut, *Tokyo Cancelled*, a meditation on metamorphosis, transit and dislocation. This text combines magical realism, folktale, fantasy and myth in order to represent the overlapping and interconnected worlds of globalized modernity.
Essential reading:

Background reading:

Week 10 | The End: Writing Back to Death, Writing Towards Death (KA)
How do writers approach death? In this session we will consider narratives that look back at death, as well as narratives that look forward in time to it. Alison Bechdel’s *Fun Home* is a graphic novel that circles around her father’s apparent suicide and his disavowed homosexuality; and Gillian Rose’s philosophical memoir, *Love’s Work*, is an exploration of death, illness, and Jewishness that starts from her own cancer diagnosis; she died shortly after the book was published. Bechdel’s recursive and multi-layered narrative returns obsessively to her father’s death, as she attempts to relate his life to her own, and Rose’s narrative writes into her own death. We will explore the narrative relationships to time in both these texts, as well as consider how writing towards death relates to awareness of climate catastrophe. Is there a
relationship between writing about impending individual tragedy and narratives confronting the potential collapse of the future?

**Essential reading:**
- Alison Bechdel, *Fun Home* (Jonathan Cape, 2006)

**Background reading:**
- Donna Haraway, *Staying With The Trouble* (Duke University Press, 2016)

**Week 11 | Superfluous Life: Precarity and Representation (SO)**
What does it mean to speak of a precarious present? In the opening decades of the twenty-first century, work has become increasingly precarious. But precarity reaches beyond the gig economy to saturate the entirety of contemporary capitalist societies. This session will explore the social forms precarity takes in Ashley McKenzie’s debut film, *Werewolf*, from drug addiction and precarious employment to the gendered labour of crisis management. We will approach precarity as a problem for representation—noting how its subjective appearance takes on forms of disposability, superfluity and waste—in order to ask how contemporary cinematic realism responds to this representational challenge.

**Essential reading:**

**Background reading:**
Core Course: The Writing Workshop  
(PT Students: Spring Term, Year 1; FT Students, Spring Year 1)

ENHU039S7  
Wednesday  
6:00pm-8.30pm  
Tutors: Toby Litt, Jodie Kim, Mark Blacklock

This workshop centres upon students' own writing (5000 words maximum per submission). There will be no published texts used in the workshop. Instead ongoing reference will be made to specific examples of contemporary writing that relate in some way to each student’s work. You will have the opportunity to continue writing short stories or begin to develop a novel with the critical support of the class.
Module Outcomes and Aims
- Develop to a professional level the craft of writing
- Develop confidence, sensitivity and discernment in their analysis of their own and their fellow students' work
- Develop a greater critical understanding of contemporary literary developments
- Place their own writing in the context of developments in contemporary fiction
- Develop to professional level a skill in editing both their own and fellow students' creative work
- Gain a greater practical knowledge and understanding of the markets for fiction

Essential Reading:

Coursework and Assessment

<table>
<thead>
<tr>
<th>Assignment</th>
<th>Description</th>
<th>Weighting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Coursework</td>
<td>5000 words</td>
<td>100%</td>
</tr>
</tbody>
</table>

Coursework Deadline
2pm, Monday 27th April 2020

Required Texts Reading

Further Reading
Bennet, Alan, Writing Home (Faber, 1998)
Berger, John, Ways of Seeing, (Penguin, 1972)
Cixous, Hélène, Three Steps on the Ladder of Writing (Columbia University Press, 1993)
Cuddon, J. A., Book of Literary Terms and Literary Theory (Penguin, 1992)
Eagleton, Terry, Literary Theory (Blackwells, 1996)
Sellers, Susan, ed., Taking Reality By Surprise (Women's Press, 1991)
Core Module: Key Concepts in Cultural and Critical Studies 2 (ENHU004S7)
(PT Students: Autumn Term, Year 2; FT students: Autumn Term, Year 1)

Thursdays 6.00-7.30pm

Module Convenor: tbc
Pre-module contact: Anna Hartnell, a.hartnell@bbk.ac.uk
Module Code: ENHU004S7
Module Level: 7
Timetable: Thursday 6-7.20pm, Autumn Term

Part One: Technology and Cultural Theory

This block focuses on a series of important topics examining the convergence of technology and cultural theory. By examining technological, political, and cultural change, we will consider how 20th and 21st century theory has interpreted the relationship between the human and the technologically saturated contemporary world. This interdisciplinary module forms links with history, science, and philosophy while maintaining a firm focus on cultural theory. The diverse range of topics will encourage students over the five-week block to debate and explore increasingly poignant ontological issues of the present and future world.

General Reading

Week 1: Art and Reproducibility
In this introductory section, we start the unit with Walter Benjamin and examine his canonical 'The Work of Art' essay. The intent is for this seminar to connect back to your reading on the Frankfurt school.

Primary reading:

Week 2: The Technological Sublime and Enframing
For David Nye the technological sublime is the magnificence of geographical, industrial, or architectural structures, which conjure strong emotional responses, typically feelings of fascination, pleasure, or pain. In the work of Martin Heidegger, enframing can be defined as ‘an apparatus’ or ‘skeleton’ through which to view the natural world. While Heidegger is not opposed to technology itself, he challenges human reliance on it and how it disguises ‘the truth of Being’ and harms the relationship between the human and the authentic world. How Nye’s work on the sublime supports or challenges Martin Heidegger’s early work on technological enframing will be discussed.

Primary reading:


Further reading:

Week 3: Communication and Control in Animal and Machine: Cybernetics

The cybernetic movement (as it is now known) emerged in 1948 and concerned the study of the processes and behaviours of organic and artificial systems. Cybernetics argues that everything is under the control of a working system. This week, focusing on the Norbert Weiner, we will examine the idea of cybernetic ‘system control’ and how this was being depicted in understandings of both human behaviour and machine development. Why did this movement develop? What does the cybernetics theory suggest about technology, science, and state in the mid-twentieth century? How was behaviour being reconsidered with this advance? Without delving into the mathematics behind the theory, we will examine the ways in which cybernetics reconsidered the relationship between human and machine.

Primary reading:
Wiener, Norbert, ‘Cybernetics’, Bulletin of the American Academy of Arts and Sciences, 3.7 (1950), 2-4

Further reading:
George, F. H., Cybernetics (Kent: Hodder & Staughton, 1981) Harrington, Jan L., Technology and Society (London: Jones and Bartlett Publishers, 2009) [I suggest reading the introductions to these texts and avoiding the mathematics]
Wiener, Norbert, *Cybernetics: Or Control and Communication in the Animal and the Machine*, 2nd edn (Cambridge: MIT Press, 1980) [I suggest reading the introductions to these texts and avoiding the mathematics]

**Week 4: Medium and Reproduction**

Looking at Marshall McLuhan’s idea of ‘vanishing point’ and ‘global village’, we will explore how human *presence* has altered with the advent of new technologies. With contemporary discussions of augmented reality and virtual reality, it seems to be evident that what we call ‘reality’ is under pressure in the contemporary world. For Jean Baudrillard, who we will be discussing this week, the disappearance of ‘the real’ is a direct result of living in ‘the era of murder by simulation’. Baudrillard conceives of four levels of simulation that are progressively more dangerous than the last. For Baudrillard, the most pressing concern of our times is ‘the production and reproduction of the real’. How has technological development and cultural theory challenged the idea of the ‘real’ and ‘authentic’?

**Primary reading:**


McLuhan, Marshall, *The Medium is the Massage: An Inventory of Effects* (Madera: Gingko Press, 2001)

**Further reading:**


——— *Understanding Media* (London: Routledge, 2008)


Week 5: Posthumanism and Singularity

Posthumanity partly concerns our anxieties and enthusiasm for both technological and human evolution. The word ‘post’ suggests the death of the former biological template through the superseding of another. The notion that technological progression is moving towards a revolutionary event is widely articulated in the ‘Technological Singularity’ – a concept fixed by Vernor Vinge in the 1990s. The Singularity could manifest through one of the following breakthroughs: artificial intelligence, intelligent networks, the merging of organic and artificial ‘interfaces’, and biological engineering. How does cultural theory deal with the convergence of biological and technological evolution? How does cultural theory help us examine contemporary issues within cultural experience? When did the posthuman happen? Will the term ‘human’ be relevant in the future?

Primary reading:

Further reading:
Pepperell, Robert, The Posthuman Condition: Consciousness Beyond the Brain (Bristol: Intellect, 2003)

Week 6: Reading Week: no class
Part Two: Globalization and its Discontents

The later twentieth century and the beginnings of the twenty-first century have been characterized by profound changes in social structures and distribution of political and cultural power. Late capitalism in dominant western cultures and the increasing industrialization in the developing world have created the process we now know as globalization. Knowledge of the theories of globalization is essential to the critical vocabularies of cultural analysis and this block will introduce students to some of the central concepts and debates which have emerged in studies of globalization.

Tracing the path of globalization through various central and related terms – postmodernism, postcolonialism, neoliberalism – the block will explore the politics of globalization in the context of various anti-globalization movements, including the current wave of resistance to globalization that is arguably shaping our contemporary moment. We will then go on to analyse the implications of modes of activist engagement and resistance via the most globalized of mediums, the digital; and conclude by exploring the fallout from globalization with respect to one of its potentially most catastrophic arenas – the environment and climate change.

A note on weekly readings: each week we will read several texts, but the key text(s) of the week has been highlighted below; please prioritize reading the key text(s), although all texts will be discussed during the seminar. Where possible, primary readings will be made available as electronic versions on Moodle.

Week 7: Globalization and the postmodern

Theories of the so-called postmodern age tell us that the coordinates that have shaped thought and material experience in the west – time and space – have changed dramatically in the later twentieth century. This session will introduce the block by exploring how our concepts of time and space have changed, and the implications this has for thinking about cultural politics against the national and the global horizons.

Primary reading

Key text:


Please also look at:


Further reading
Mike Crang and Nigel Thrift, eds, Thinking Space (London: Routledge, 2000).

Week 8: Globalization and the postcolonial

The session will examine the politics of globalization via the relationship between globalization and the postcolonial, and within the context of theories of US imperialism. In particular, we will be thinking about these issues in relation to feminist politics and recent events in the Middle East that began with the ‘Arab Spring’ in 2011.

Primary reading

Key texts:


Please also look at:

Further reading

**Week 9: Globalization and neoliberalism**

This session will explore the consequences of the transformation in global capital that ensued from the mid-1970s onwards, that many argue inaugurated a new phase of capitalism: neoliberalism. We will explore theories of neoliberalism and the neoliberal state via its western iterations in the UK and the US, and its neocolonial exportation to the developing world.

**Primary reading**

**Key text:**

Please also look at:


Further reading
David Harvey, A Brief History of Neoliberalism (Oxford: Oxford University Press, 2005).

Week 10: Globalization and the digital

Computational practices and digital culture are central to contemporary finance capitalism and global communication systems. This session explores the internet as a potential platform for political activism and civic engagement, given the fact that it is also a key site for financial transactions, marketing and data harvesting – activities that are pivotal to what many argue is the current form of predatory capitalism that threatens democracy. The first glimpses of cyberspace were often imagined as utopian, a site of liberation – how realistic were these early visions for our contemporary world?

Primary reading

Key text:


Please also look at:
Further reading

Week 11: Globalization and the planet
This session reframes the debates about globalization we’ve been tracing through the prism of climate change. Scholars of the environmental humanities have identified a new geological period, the Anthropocene, in which human beings have themselves been identified as geological agents: how does the history of globalization fit within this periodization? We will explore the challenges to thinking on globalization posed by certain types of ecological and environmental awareness.

Primary reading

Key text:


Please also look at:

Further reading
Creative Non-Fiction
ENHU002S7
Tuesday
6:00pm-8.30pm
Tutors: Julia Bell, Richard Hamblyn

Module Description
“*We like non-fiction because we live in fictitious times*” – Michael Moore

This ten-week module aims to develop the understanding and practice of non-fiction writing in all its forms, covering all aspects of the craft from ideas to research and writing. It will be taught through an interactive mix of reading, writing, discussion and peer appraisal.

The course will be split into two five week periods. The first five weeks focus on reading, discussion, and exercises. The second five weeks will give every student an opportunity to workshop ONE piece of work of up to 5,000 words.

During the first 5 weeks each student will be expected to deliver a short (8 minute) presentation on that week’s set text. The presentation can be about any aspect of the book that interests them, but as well as subject, we will be looking at structure, delivery, style and technique.

**EVERYONE** is expected to read the five set texts – even if they are not presenting - the secondary reading would be helpful but is not essential.

The **assessment** for the course will comprise a piece of original Creative Non-Fiction of up to 5,000 words. Each student will have ONE 30 min tutorial will the tutor in the second half of term.

Module Outcomes and Objectives
By the end of this module students will have gained:

- An awareness of the styles, forms and elements of the non-fiction writer’s craft, including the processes of research and exposition.
- An understanding of recent and contemporary creative non-fiction across a range of forms and genres (travel, nature, life writing, reportage, creative documentary, verbatim theatre), and an understanding of its place within literary canons.
- The confidence to tackle craft-related problems in areas such as structure, setting, atmosphere, and the use of dialogue and telling detail.
- The confidence to recognise and understand sources of inspiration and creativity.
The ability to use research-generated ideas more confidently, precisely, and imaginatively.
Confidence in handling a variety of research methodologies (whether electronic, archival, interview-based or investigative), with insight and creativity.
An awareness of the industry-standard expectations for the presentation of non-fiction writing, including its bibliographic and citation conventions.
Enhanced skills of self-evaluation as well as constructive analysis of the work of others.
The critical and creative skills needed to realise a personal writing project, taking it from initial idea, through research to writing and editing.

**Module Content**

<table>
<thead>
<tr>
<th>Week</th>
<th>Module</th>
<th>Content</th>
</tr>
</thead>
<tbody>
<tr>
<td>Week 1</td>
<td>Plenary Session</td>
<td>Introduction: the ‘truth’ vs the Truth</td>
</tr>
<tr>
<td></td>
<td></td>
<td><em>What The Garbageman Knows.</em> Peter Hessler (New Yorker)</td>
</tr>
<tr>
<td>Week 2</td>
<td>Politics</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Funder, Anna – <em>Stasiland</em> (Granta 2011)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Secondary Reading: Orwell, George, <em>Down and Out in Paris and London</em></td>
</tr>
<tr>
<td></td>
<td></td>
<td>(Penguin Classics 2001)</td>
</tr>
<tr>
<td>Week 3</td>
<td>Workshop 1</td>
<td></td>
</tr>
<tr>
<td>Week 4</td>
<td>Place</td>
<td></td>
</tr>
<tr>
<td>Week 5</td>
<td>Workshop 2</td>
<td></td>
</tr>
<tr>
<td>Week 6</td>
<td>READING WEEK</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Personal</td>
<td>Winterson, Jeanette, <em>Why Be Happy When You Could Be Normal</em> (Vintage,</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(2012); vs <em>Oranges Are Not The Only Fruit</em> (Vintage, 1991)</td>
</tr>
<tr>
<td>Week 7</td>
<td>Workshop 3</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Set essay</td>
</tr>
<tr>
<td>Week 8</td>
<td>Society</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Didion, Joan, <em>The White Album</em> (FSG 2009)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Baldwin, James, <em>The Fire Next Time</em> (Penguin)</td>
</tr>
<tr>
<td>Week 9</td>
<td>Workshop 4</td>
<td></td>
</tr>
<tr>
<td>Week 10</td>
<td>Workshop 5</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Assignment</th>
<th>Description</th>
<th>Weighting</th>
</tr>
</thead>
</table>

40
Coursework

The assessment is via a 5,000-word piece of original creative non-fiction.

100%

Coursework Deadline
2pm, Monday 27 April 2020

Further Reading

Essential

Cline, Sally and Midge Gillies, *The Arvon Book of Literary Non-Fiction* (Bloomsbury, 2012)

Recommended

Bechdel, Alison, *Fun Home A Family Tragicomic* (Jonathan Cape, 2006)
Bourdain, Anthony, *Kitchen Confidential* (Bloomsbury, 2000)
Carey, John (ed.), *The Faber Book of Reportage* (Faber, 1996)
Clanchy, Kate, *Antigone and Me* (Picador, 2010)

*Granta 66: Truth + Lies* (Granta, 1999)

*Granta 102: The New Nature Writing* (Granta, 2008)

Greenlaw, Lavinia, *The Importance of Music to Girls* (Faber, 2007)
Gutkind, Lee (ed.), *In Fact: The Best of Creative Nonfiction* (W. W. Norton, 2005)
Hammond, Will (ed.), *Verbatim Verbatim: Techniques in Contemporary Documentary Theatre* (Oberon, 2008)
Hersey, John, *Hiroshima* (1946; Penguin Modern Classics, 2002)

Jack, Ian (ed.), *The Granta Book of Reportage* (Granta, 2006)

Jamie, Kathleen, *Sightlines* (Sort Of Books, 2012)


Kingsolver, Barbara, *Small Wonder: Essays* (Faber & Faber, 2002)


Masters, Alexander, Stuart: *A Life Backwards* (Harper Perennial, 2007)


Oswald, Alice, *Dart* (Faber and Faber, 2002)


Schama, Simon, *Dead Certainties: Unwarranted Speculations* (Granta, 1991)


Wallace, David Foster, *Consider the Lobster, and Other Essays* (Abacus, 2007)

Core Course: Dissertation
Module Convenor: Dr Katherine Angel
Module Code: AREN235D7
Module Level: 7
Timetable: Spring Term and Summer Term

The dissertation can take two distinct forms.

The first option is a submission of two interconnected pieces: a creative text alongside a critical text, of 7,500 words each. The two elements will be in dialogue with one another.

The second option is a creative-critical text, of 15,000 words, that incorporates creative and critical work to produce a hybrid text.

Outcome and aims
- Students will, with the guidance of a supervisor, consolidate and develop the creative and critical writing skills they have acquired at level 7.
- Students will plan, research, and structure the argument of a substantial piece of critical writing.
- Students will develop to a professional level the craft of writing
- Students will demonstrate a persuasive connection between the creative and critical elements of the dissertation.

Assessment
- The dissertation constitutes 33% of your final mark.
- You are required to offer a presentation on your work, but this will not count towards your final mark.
- The dissertation will either comprise 7,500 words of creative material and 7,500 words of critical material, or be a hybrid 15,000 words of creative-critical

Supervision
PT students will have a first meeting in autumn of their second year, with the MA Director. A dissertation proposal form should be submitted at the start of the Spring Term; students will then have three supervisions with their allotted supervisor, usually one in Spring Term, and the subsequent two in Summer Term.

The dissertation proposal form is in the Appendices section of this booklet. You'll be asked to submit this via turnitin assignment on Moodle. There is nothing official about the outline you provide us, and we don’t expect a perfectly conceived project. However, it is on the basis of this outline that you will be assigned a supervisor, so it is important that you have a sense of a topic by this point, so that you can begin
meeting your supervisor from the beginning of the summer term. We will try to align your work with the most suitable person on the staff, where this is possible. You may wish to approach members of staff (including personal tutors and course tutors) for advice or discussion about the potential of possible projects well before this date. It is good to start thinking about the dissertation relatively early.

The MA director will inform students of their supervisors in the first few weeks of the Spring Term. It’s up to the student to contact tutors to arrange a first meeting. Students and supervisors should then arrange a further two supervisions (three in all), each one hour long, which must be completed by July that year.

In the course of these meetings supervisors may be asked to comment on plans or on drafts of part of the dissertation. Your supervisor may help you to clarify your main thesis; aid you in shaping your thoughts into an appropriate scale; suggest further reading or lines of library research; advise you on methods of writing and research. It is advisable to pencil in the future meeting dates at your first meeting.

Throughout the Summer Term, Creative Provision and Research Provision (see above) will be important and useful resources. Depending on the form of your dissertation, you may find it useful to attend the research skills dissertation workshops taking place on Wednesdays in weeks 2, 3, and 5. You are also required to give a presentation on your dissertation in week 11. And the Summer Term Lecture series on Tuesday evenings will also be useful. Your dissertation supervisor and the MA Director will be able to advise on what resources and methods will be best for your given dissertation plans.

**Useful texts for Dissertation Writing Skills** (your dissertation supervisor will advise more specifically, dependent on your chosen dissertation format)

Assessment Information

MA Assessment

The dissertation counts for: **33%**
The four core essays count for: **67%**

(All students submit four core essays.)

For a distinction to be awarded, the numerical average of the dissertation and the four essays must be at distinction level (70 or above).

For a merit to be awarded, the numerical average of the dissertation and the four essays must be at merit level (60-69).

For a pass to be awarded, the numerical average of the dissertation and the four essays must be at pass level (50-59).

Students are entitled to make one attempt, per piece of coursework, to make good failed essays. Resubmission must take place by the next coursework deadline following the return of the failed piece of coursework to the student (e.g. Autumn term essays submitted in January must be resubmitted by the April deadline; Spring term essays must be submitted by the September deadline).

Resubmitted work will normally consist of a second attempt at the same topic.

Students are entitled to resubmit a failed MA dissertation on one occasion only. An extension of up to one year may be granted for resubmission. Students must pass the dissertation in order to pass the degree programme.

Students who fail two pieces of coursework must suspend their studies until they have made good at least one of the failed essays.

**The essays and dissertations are double-marked, and overseen by an external examiner.**

See below for Grade-Related Criteria.
Grade-Related Criteria – Critical

These are the criteria assessors and the exam board apply when marking your essays and dissertations.

A Pass should show:
- Present a reasonably clear argument with some level of detail;
- Show a fair ability to marshal evidence, even if this is not quite sustained throughout the essay;
- Display a reasonably thorough knowledge of the relevant primary sources and texts;
- Demonstrate a fair grasp of a reasonable range of secondary literature relevant to the essay topic;
- To some extent situate the topic in hand within a broader historical and/or intellectual context;
- Use appropriate scholarly conventions relating to presentation;
- Be adequately documented, with footnotes or endnotes, and a Bibliography that reveals engagement with relevant primary and secondary texts.

A Merit should also show:
- Present a clear and detailed argument;
- Marshal a large body of evidence confidently and clearly throughout the essay;
- Display a thorough knowledge of the relevant primary sources and texts;
- Demonstrate a good grasp of a range of secondary literature relevant to the essay topic, including recent work in the field, and be able to engage with as well as rehearse current or recent debates on the topic in hand;
- Effectively situate the essay topic within a broader historical and/or intellectual context;
- Be very well written throughout;
- Be presented in a proper scholarly fashion throughout;
- Be well documented, with footnotes or endnotes, and a full Bibliography that reveals engagement with relevant and recent primary and secondary texts.

A Distinction should also show:
- Fulfil all the criteria of a MERIT essay and, additionally:
- Show a level of intellectual ambition beyond what is required for a MERIT mark;
- Display some evidence of originality in the selection of and/or interpretation of primary sources;
- Have a wide range of reference, beyond what is required for a MERIT mark.
Grade-Related Criteria – Creative

Short Creative Pieces

A Pass should show:
- Engagement with the structure and conventions of a particular genre
- Understanding of the relationship between content and form
- Competent use of language (including grammar, syntax, spelling, punctuation)
- Awareness of reader/audience

A Merit should also show:
- Confident handling of the structure of a particular genre
- Willingness to experiment
- Fresh (i.e. non-clichéd) use of language
- Precise wielding of grammar, syntax, spelling, and punctuation
- Ability to explore and convey ideas and themes within creative forms

A Distinction should also show:
- Ambitious and/or original choice of content
- Accomplished handling of chosen form
- Original, unique use of language
- Excellent wielding of grammar, syntax, spelling, and punctuation
- Ability to explore, subtly and powerfully, ideas and themes within creative forms
Grade-Related Criteria – Creative-Critical Hybrid

A Pass should show:

- A weaving together of creative and critical elements
- The exploration of ideas and arguments within a creative form
- Awareness of form
- Competent use of language (including grammar, syntax, spelling, punctuation)

A Merit should show:

- A confident weaving together of creative and critical elements
- Assured exploration of ideas and arguments within a creative form
- Awareness of form and willingness to experiment with form
- Fresh (i.e. non-clichéd) use of language
- Precise wielding of grammar, syntax, spelling, and punctuation
- A significant contribution at the level of ideas and at the level of creative voice

A Distinction should show:

- Ambitious and original weaving together of creative and critical elements
- Accomplished exploration of ideas and arguments within a creative form
- Original, unique use of form, and of language
- Excellent wielding of grammar, syntax, spelling, and punctuation
- Ability to explore, subtly and powerfully, ideas and themes within creative forms
- An original and compelling contribution at the level of ideas and at the level of creative voice

Assessment

All essays are double marked, that is, they are marked by two members of staff. Essays are returned to students with a set of comments and a mark. This mark has been agreed by two internal markers. Marks remain unconfirmed until the exam board, which takes place in November. A selection of students' work is seen by our external examiners, who are the final adjudicators of assessed work. Once marks have been agreed by the exam board they cannot be altered. The exam board will take into account any mitigating circumstances that have been accepted, confidentially, by the Sub-Board, and makes decisions about penalties for late or missing work.

Marking Scale

<table>
<thead>
<tr>
<th>Score Range</th>
<th>Grade</th>
</tr>
</thead>
<tbody>
<tr>
<td>70-100</td>
<td>Pass with distinction</td>
</tr>
<tr>
<td>60-69</td>
<td>Pass with merit</td>
</tr>
<tr>
<td>50-59</td>
<td>Pass</td>
</tr>
</tbody>
</table>

Marks below 50 constitute a ‘fail’. 
Plagiarism

Plagiarism, the act of taking somebody else's work and presenting it as your own, is an act of academic dishonesty, and Birkbeck takes it very seriously.

Examples of plagiarism include (but are not restricted to):

- copying the whole or substantial parts of a paper from a source text (e.g. a web site, journal article, book or encyclopaedia), without proper acknowledgement
- paraphrasing another's piece of work closely, with minor changes but with the essential meaning, form and/or progression of ideas maintained
- piecing together sections of the work of others into a new whole
- procuring a paper from a company or essay bank (including Internet sites)
- submitting another student's work, with or without that student's knowledge
- submitting a paper written by someone else (e.g. a peer or relative) and passing it off as one's own
- representing a piece of joint or group work as one's own.

If you knowingly assist another student to plagiarise (for example, by willingly giving them your own work to copy from), you are committing an examination offence.

What happens if plagiarism is suspected?

The College operates a three stage policy for dealing with assessment offences. The first stage allows for a very rapid and local determination for first or minor and uncontested offences. Stage two allows for a formal Department investigation, where a student wishes to contest the allegation or penalty, where there is an allegation of a repeat offence or for more serious cases. Stage three involves a centrally convened panel for third and serious offences, dealt with under the code of Student Discipline.

What if I am worried that I’m not referencing correctly?

Please see your module tutor or contact a member of the learning support team as soon as possible.
Please refer to the Birkbeck website for updated information on assessment offences here: http://www.bbk.ac.uk/student-services/exams/assessment-offences

Please access the assessment offences policy here: http://www.bbk.ac.uk/registry/policies/documents/assessment-offences-policy.pdf
Collusion

Like plagiarism, ‘collusion’ is an assessment offence. Any piece of writing you submit must be your own work. In the humanities, the way you structure your argument and express yourself is an inherent part of producing work of the required standard, and you will be judged on that, so it is not acceptable to get an inappropriate level of help in this area.

You may ask friends, family or fellow students to proof-read your work and offer advice on punctuation, grammar, and presentational issues, but it is not acceptable for someone else to come up with your arguments for you, or to re-write a draft you have produced.

If your first language is not English, you may find your written work a challenge initially, and it is acceptable to ask someone to look over your work and give you advice on punctuation, grammar and phrasing. However, that advice must be minimal and the argument and structure of any assessment must be your own work, and written in your own words.

It is unacceptable to pay someone to write (or re-write) your essays for you and if you are discovered to have done so, you risk expulsion from the programme. The College and the School of Arts have a range of services in place to help you improve your academic writing, so if you are concerned at all and would like some additional support, you should contact your personal tutor or the Programme Director.

Please refer to the website for further details here: [http://www.bbk.ac.uk/student-services/exams/assessment-offences](http://www.bbk.ac.uk/student-services/exams/assessment-offences)
Essay Guidelines and Advice: Coursework Submission, Return of Coursework and Late Submissions

Essays
Essays should be 5,000 words long (with the exception of MA Creative Writing components; word length for each as stated in module syllabus). Please note that excessively over- or under-length work will be penalised. Also, please be aware of the university regulations against plagiarism and duplication of your own work (i.e. there should be no overlap between this essay and material presented for assessment elsewhere in this course or in another module). Please ensure that your essay follows the style of referencing outlined in the MHRA stylebook. This is available on the web at: http://mhra.org.uk/publications/books/styleguide/styleguideV1.pdf.

General
Students sometimes ask if they may write on an author who does not write in English. The bibliographies of a number of our modules include works in translation, especially contextual and theoretical works, and it is fine to discuss these in essays and the dissertation. However, the primary source material of assessed work should normally have been written in English. If you have a strong reason for wanting to write on an author who does not write in English, you should discuss this with the course convenor. Factors relevant to the choice of primary material for essays and the dissertation include whether you will be able to obtain the relevant secondary materials in the libraries open to you, and whether the module convenor is able to evaluate the work properly. Material by foreign language authors must be available in translation.

It may be that your course tutor issues a list of questions, one of which you must answer in your essay. In other cases, your tutor may encourage you to devise your own question. In any case, your essay must be relevant to the course you have taken, in terms of both subject-matter and approach. If you are in doubt as to whether what you want to write is relevant, you should discuss it with your course tutor. It is a good idea to take notes on this discussion, write a brief note recording it and share it with your tutor, so that you both have a clear, written idea of what your intentions are regarding your essay.

The criteria we normally use for making judgements about the range of assessed work, and their relation to the categories of Pass, Merit and Distinction, are set out formally in the Grade Criteria document above. It acts as a summation of our expectations, and should not be regarded as a check list but as useful guidance.
Submission of coursework

All work should be computer-generated (using a format compatible with Microsoft Word, and not a pdf or similar) unless you are told explicitly that an assignment may be hand-written. All work should be submitted double-spaced. Please note that the word count should include footnotes but excludes the bibliography.

Put your name and/or student ID number and the title of the module at the top of the essay, and include the title of the essay or the question as set out on the list of essay topics. Word count should be indicated at the end of the essay.

You may exceptionally, in addition to electronic submission via Moodle, be asked to submit a paper copy. You should also always retain a copy yourself.

Please note that electronic submission is normally required by 14:00 on the day of the deadline.

Please also note that we require electronic submission of your work for the following reasons:
- Some work will be marked online via Turnitin;
- Electronic submission is essential for purposes of moderation (second marking and External Examiner scrutiny);
- All work submitted online is automatically screened for plagiarism;
- We are required to retain a copy of all student work for up to five years after graduation.

For further information and instructions on how to submit essays using Moodle, please see Appendix A or visit the ITS Help Desk in Malet Street building.

Return of Coursework
Coursework will usually be marked and returned electronically within 4 weeks from the stated submission date or the date of handing in. Larger modules and modules with numerous seminar groups, such as core modules, could take longer due to the number of students involved. There may also be a delay if the college is closed or if there are extended holidays during that 4 week period.

Late Submission of Coursework
All Schools and Departments across the College have moved to a system whereby students are not permitted to ask for extensions to coursework deadlines. If for some reason you are unable to submit a piece of work by the stipulated deadline, you should complete a Mitigating Circumstances form, which you can download here.
This form gives you space to describe the circumstances that have prevented you from meeting the deadline, and requires you to provide supporting evidence (such as a medical certificate). It is advisable to discuss the situation with your personal tutor before submitting the form.

**Mitigating Circumstances forms** should be emailed to the course administrator or handed in to the Department office within 14 days of the deadline. Submission after that date must be in line with the College procedure for ‘Appeals Policy (Taught)’. Claims that do not include relevant information or documentary evidence will not be considered except where the relevant evidence has previously been submitted to the College’s Disability and Dyslexia Service, in which case the Department may use that evidence when considering the claim. Acceptance of mitigating circumstances claims is at the discretion of the College only. All information submitted as a claim of mitigating circumstances will be treated as confidential.

When you receive a late submitted piece of assessed work back from the markers, you will find that you have been awarded two grades: a penalty mark of 50% LP (late pass) for postgraduate students, assuming it is of a pass standard, and the ‘real’ mark that would have been awarded if the work had not been late. When the Mitigating Circumstances Sub-Board has met and considered your form, you will be told which of these marks will stand. If your claim has been accepted, the essay will receive the grade it has been deemed worth. If your claim is rejected, you will receive the LP mark.

Please note that Mitigating Circumstances Sub-Board will normally meet two weeks before the final exam board and claims will not be processed until then. Please see the Birkbeck College website for further details on Mitigating Circumstances.

**Note:** If you are taking an option within another School please note that you will need to adhere to the deadline/ extension policy of the School in which the option course is based.

**Dissertations**

It is particularly important to submit dissertations on the deadline date. This deadline is not negotiable. If missed, the candidate may not be examined in the same year and may have to wait another twelve months before being awarded the degree as MA examination boards meet only once a year, in November. Any difficulty in meeting the dissertation deadline should be brought to the attention of the Programme Director at the earliest opportunity.

**College Assessment Policy**
For further information please familiarise yourself with the College online assessment pages and awarding regulations. See the following links for requirements and policies:

Registry Policies
Writing essays at graduate level demands a more rigorous and scholarly attention to detail than undergraduate essays: you must fully reference all sources, and do so in a systematic and coherent way. You will see a number of systems of reference in books and journals. The Department of English & Humanities advocates use of the MHRA style described below, with information taken from the *MHRA Style Guide* (London: Modern Humanities Research Association, 2004), which should be consulted for further explanation. Libraries hold copies of this style guide, and you can buy it in good bookshops (including Waterstones, Gower Street). It can also be downloaded for personal use from:

Please try to get into the swing of using this system consistently as early as possible; this will make writing the dissertation easier. It also means that every time you read an article you should take a note of its **author, title, journal volume number/date and inclusive page numbers** (or, with books, its **place of publication and publisher**). This will avoid the tedious business of having to go back to the library to scrounge around for the essays you’ve read in the distant past minutes before the deadline expires.

One final word: don’t worry if this looks completely impenetrable to you at first—referencing is a discipline which takes time to learn.

**Titles in the essay text:**
Italics, or underlinings (use one or other, not both), are used for the titles of all works individually published under their own titles: books, journals, plays, longer poems, pamphlets, and any other entire published works. The titles of chapters in books or of articles in journals should be enclosed within single quotation marks. The titles of poems or essays which form part of a larger volume or other whole, or the first lines of poems used as titles, should also be given in single quotation marks:
Titles of films, substantial musical compositions, and works of art are italicised. Titles of songs and other short individual pieces are enclosed within single quotation marks.

**Quotations:**
Short quotations (not more than about forty words of prose or two complete lines of verse) should be enclosed in single quotation marks and run on with the main text. If not more than two complete lines of verse are quoted but the quotation includes a line division, this should be marked with a spaced upright stroke (/). For a quotation within a quotation, double quotation marks should be used:

Mrs Grose replies that ‘Master Miles only said “We must do nothing but what she likes!”’.  

59
If a short quotation is used within a sentence, the final full point should be outside the closing quotation mark; it may also be appropriate to alter the initial capital in such a quotation to lower case:

Do not be afraid of what Stevenson calls 'a little judicious levity'.

Long quotations (more than about forty words of prose, prose quotations consisting of more than one paragraph even if less than forty words, and verse quotations of more than two lines) should be broken off by an increased space from the preceding and following lines of typescript, and indented an inch (normal new paragraphs of text should always be indented half an inch). They should not be enclosed within quotation marks. Long quotations should normally end with a full point; even though the original may use other punctuation, there is no need (except for a question mark or exclamation mark) to preserve this at the end of a quotation. Omissions within prose quotations should be marked by an ellipsis (three points within square brackets: [...]). Omitted lines of verse should be marked by an ellipsis on a separate line.

References:
When you include material in your essay that you have drawn from another work, either from a literary text or from another critic, you must provide a footnote or endnote that gives the details of your source. All quotations, therefore, will be accompanied by a note, but so will any information you include that you have learned from the essays, articles, history books, reference works and electronic resources you might have read for your essay. Your marker will want to know what you have consulted for information, and will sometimes want to look at the source themselves. But the even more important reason for citing sources is that failure to provide full details of sources constitutes an act of plagiarism, it suggests that you are passing off someone else’s work as your own, and this offence carries severe penalties that may lead to your expulsion from the course (see section 10).

Your word-processing software may have a footnote function (usually in the ‘Insert’ pull-down menu), if it does not, notes should be placed as a numbered list at the end of the essay. Numbers for notes are usually placed at the end of the sentence, after punctuation, such as commas or full stops, and quotation marks: ‘Mrs Grose replies that ‘Master Miles only said “We must do nothing but what she likes!”’. If your computer does not have a footnote facility, or the facility to place numbers in superscript, then place the number of the note in brackets: ‘Mrs Grose replies that ‘Master Miles only said “We must do nothing but what she likes!”’ (1). To convert a number to superscript in Word, highlight it, go to ‘Format’, then to ‘Font’ and tick the ‘superscript’ box.

The footnotes or endnotes themselves should be set out as follows:

Books

The author’s name is given as written on the title page of the book. The title is given in italics (or can be underlined instead), and the main title is separated from the subtitle by a colon (even if the punctuation on the title page is different). The place of publication (city, not country) comes next, then the name of the press (without secondary matter such as ‘& Co.’, ‘Ltd.’). Remember to include the page number your quotation is drawn from, preceded by ‘p.’ for ‘page’, or ‘pp.’ for ‘pages’.


If the book you are using has been translated or edited by someone, you should include their name, as above. However, it is the main author, rather than the translator or editor, whose name appears at the beginning of the note (here Starobinski, rather than Goldhammer). If you are using a book of letters or diary entries, for example, that contains the name of the main author within it (as here with Dickinson’s *Selected Letters*), you do not need to repeat the author’s name at the beginning of the citation.

You should also specify which edition of a book you are using, if it is not the first edition of the work in question (here, the second edition of Dickinson’s *Selected Letters*), because different editions may contain different material, or have different page numbering.


If the work you are citing is a reference work, such as a dictionary or a guide to English literature, the reference should begin with the title of the work, rather than the name of the editor. If there are more than three editors or authors of a work, use the first name on the title page and ‘and others’. If one volume of a multi-volume work has been used, the volume number should be given in roman numerals (here six has been turned into vi). ‘p’ is usually omitted if a volume number is given.

Chapters or articles in books

The title of the chapter or article is put in single quotation marks and followed by the word ‘in’, then the name of the book, with full publication details. The first and last page numbers of the article or chapter should be given, preceded by ‘pp.’, and finally, the page number to which you are referring should be given in brackets, preceded by ‘p.’, or, if you are referring to more than one page, ‘pp.’.

**Articles in journals**


The name of the article is followed directly by the name of the journal in which it appears, without the ‘in’ used for chapters in books (see above). After the title of the journal, give the volume number of the journal (without writing ‘volume’ or ‘vol.’) and if the volume number is given in roman numerals, convert it to arabic numerals (here ‘85’, rather than ‘LXXXV’). Follow this with the year in which the volume was published (here 1990), the first and last page numbers of the article (and when referring to journal articles rather than book chapters, don’t use ‘pp.’), and finally, the page number to which you are referring, in brackets and preceded by ‘p.’ or ‘pp.’.

**Articles in newspapers and magazines**


The method of citation is the same as for journal articles, except that the date of the newspaper should be given, in place of the volume number and year.

**Electronic resources**

Electronic resources can provide useful information for use in your essays. However, their quality and authority vary widely. While CD-ROM resources available on library computers are generally reliable, internet resources such as personal websites are much less likely to be—or at least, there is no guarantee that they are. You should use books and journal articles to check any information you find on the internet, and the research for your essays should in any case extend well beyond internet resources.

When citing electronic resources, you should follow the style used for printed publications above as far as possible. Information should be given in the following order: ‘author’s name; title of item; title of complete work/ resource; publication details (volume, issue, date); full address of the resource (URL), in angle brackets; date at which the resource was consulted, in square brackets; location of passage cited, in parentheses.

E.E. (Edward Estlin) Cummings, ‘maggie and milly and molly and may’ in Literature Online <http://lion.chadwyck.co.uk> [accessed 5 June 2001].

**References where the original source is not given**

If you want to quote something that a critic is quoting, and you are not able to look at the critic’s original source, use the following form for the note:


If the year of the work, or even the title, isn’t given by the critic, you can write:


You should, however, attempt to look at the original source. Looking at the original context of a quotation is one of the ways you are able to evaluate the critic’s use of their material.

**Subsequent references**

When you refer to a source for a second time, you must still provide a footnote or an endnote, but you do not need to repeat all the bibliographical details. You can give the reference as the surname of the author, or surname and abbreviated title, if your bibliography holds more than one work by the author: ‘McArthur, p. 63’ or ‘McArthur, Worlds of Reference, p. 63’. Do not use the outdated forms of reference ‘ibid.’ or ‘op.cit.’. If you are likely to refer to a small number of works many times in an essay (if, for example, you are writing an essay that focuses on one or two books), you may identify an abbreviation in the first full reference and include all subsequent references in your own text, e.g.:


References to ‘The Turn of the Screw’ would then appear in brackets in your own text:

Mrs Grose replies that ‘Master Miles only said “We must do nothing but what she likes!”’ (TS 197).
Bibliography:
All the material referred to in footnotes or endnotes, and any other material you have consulted, must appear in a bibliography at the end of the essay. The form is the same as the notes, except that the works appear in alphabetical order, with the surname of the author or editor preceding the first name, and the page number you referred to in your essay should be omitted (inclusive page numbers of articles in journals and newspapers, or chapters in books should be retained). It is easier for your reader to find information in your bibliography if you do not divide it up into categories of work (such as ‘primary’ and ‘secondary’ or ‘books’ and ‘films’): include all works in one list. The only exception to this is archival material.

Starobinski, Jean, Montaigne in Motion, trans. by Arthur Goldhammer (Chicago: University of Chicago Press, 1986)
How to Format Your Fiction and Prose Non-Fiction

by Benjamin Wood

This document is intended to give you, the creative writing student, a general template you can refer to in order to correctly format your fiction for your assignments. It represents the standard expectations of publishers, agents, and literary journals for manuscript submissions. As you can see, the prose is double-spaced; in Microsoft Word, you do this by going to Format > Paragraph > Line Spacing > Double. This makes the prose easy to read, and gives your lecturer/editor ample space to write interstitial comments.

It is also typewritten in a sensible font (Gill Sans – though Times New Roman, Arial, Verdana, or Garamond are other good, sensible fonts) and in a sensible font size (11pt or 12pt). Further, there are ample margins of 2.5cm (Left), 2.5cm (Right), 2.5cm (Top) and 2.5cm (Bottom). You can alter the margins in Microsoft Word by going to Format > Document > Margins. The text can be justified or simply left-aligned. Pages should always be printed single-sided.

“Dialogue is indented like this,” one person said.

“And the first line of long passages of dialogue such as this, which are so long that they take up another line, are indented too,” someone replied.

In fact, every first line of every new paragraph is indented in this way. You can set up Microsoft Word to do this automatically by going to Format > Paragraph > Special > First Line.
When you want to indicate a large break in narrative time between scenes, you do so by leaving two paragraph spaces and left-aligning the prose, like this. (You should only do this when there are significant gaps in narrative time you want to imply to the reader; never do this between paragraphs of continuous action in the same scene.)

When you move onto the next paragraph, the first line should be indented again, like this. Make sure that you don’t leave additional spaces between your paragraphs by adjusting your settings in MS Word. Go to: Format > Paragraph > Spacing and check the tick-box beside “Don’t add space between paragraphs of the same style”, or “Remove Space After Paragraph”.

It seems like this sort of thing is not very important but, in fact, it is. Correct formatting creates the impression of professionalism, indicating to agents and editors that you are a writer who knows what you are doing.

Other things to note: your pages should be numbered (ideally in the bottom right-hand corner of every page). You do this in Microsoft Word by going to Insert > Page Numbers. And you should include a word count at the end of your manuscript. You can find out what your word count is by going to Tools > Word Count.

Happy writing!
Support for Students

Student Services at Birkbeck encompass a wide range of services within Birkbeck, aimed at supporting students’ learning experience and personal development.

Advice Service
Our trained advisors are on hand to provide information and advice about many aspects of your studies at Birkbeck including but not limited to: application and enrolment process, applying for government loans and financial support from the College, and payment options.

Where we cannot answer questions immediately, we will either get back to you with an answer or refer your query to a specialist team who can.

Ask us a question, call us on 020 3907 0700 or come along to our drop-in sessions for help and support. Alternatively, please visit our website for further information.

Careers and Employability Service
We provide comprehensive careers advice, events and information services both in person and online. The service is free and available to all Birkbeck students and recent graduates.

To find out how we can help you to enhance your career development and employability ask us a question or visit the Students’ Employability Space. Alternatively, please visit our website for further information.

Counselling Service
We offer a free, non-judgmental and confidential counselling service to support you with emotional or psychological difficulties during your time at university.

To make an appointment for an initial consultation, please email counselling-services@bbk.ac.uk with your name, student ID, gender and telephone number. Alternatively, please visit our website for information about the service including a comprehensive selection of self-help resources which may be useful in gaining a greater understanding of the personal challenges you are facing and the ways in which you can think about addressing them.

Disability and Dyslexia Service
At Birkbeck we welcome students with disabilities and we are committed to helping you seize the opportunities that studying here presents. Regardless of your condition, our experienced, understanding and welcoming staff are here to support you during your studies.
To make an appointment, please contact the Wellbeing Team from your My Birkbeck profile by clicking on ‘Ask us’ and selecting ‘New Ask’ or call us on 020 3907 0700. Alternatively, please visit our website for information about a Study Support Plan, Disabled Students' Allowance, free dyslexia screening and more.

**Study Skills**
Through a range of workshops, accessible learning materials, and one-to-one meetings, our Learning Development Service is here to help you to fulfil your potential in a number of ways while studying at Birkbeck. Visit our Learning Skills module on Moodle for resources that will help you build academic skills and increase academic performance. Ask a question, call us on 020 3907 0700 or visit our website for advice and support with study skills.

**Mental Health Advisory Service**
We provide specialist advice and support in a safe, non-judgemental environment. Like the Counselling Service, we are here to help you when you are going through emotional or psychological difficulties. The main difference between our services is that the emphasis of our work is on practical support, rather than therapeutic interventions, to enable you to progress through your studies.

To make an appointment, please contact the Wellbeing Team from your My Birkbeck profile by clicking on ‘Ask us’ and selecting ‘New Ask’ or call us on 020 3907 0700. For further information about the service, please visit our website.

**Nursery Service**
We understand that studying while caring for a child or children can be especially challenging and so we offer an affordable, professional evening nursery service, based in our central London campus, for children aged from two to six years.

For further information and contact details, please visit our website.
Academic and Language Support Facilities for Postgraduate Students

Centre for Transformative Practice in Learning and Teaching (CTPLT)
The Centre for Transformative Practice in Learning and Teaching (located in the Main Building, Torrington Square) provides workshops and some individual tutorial assistance to PG students. Please click on this link and look under the ‘Postgraduate Student Support’ tab on the website for further information.

One-To-One Tutorials
The CTPLT offers a number of one-to-one tutorials available each week, including during term 3. These are meant to help students with a specific aspect of their writing. Tutorials can be booked by emailing: learningskills@bbk.ac.uk. Students are asked to bring a sample of their work with them to the appointment.

Workshops Covering a Range of Skills
There are CTPLT workshops specifically for PG students. These are offered periodically throughout the year, but more frequently in Autumn and Spring terms. There is an ‘Academic Writing Day for PGs’ in May, and a day in February on referencing.

Workshops can be viewed and booked on the Academic Development Workshop Calendar. The Academic Development Workshop Calendar includes information on all workshops offered throughout Birkbeck.

Facilitated Writing Workshops
In July and August CTPLT will be hosting a series of facilitated writing workshops designed to help students engage with their dissertation writing process. These workshops are also booked through the Academic Development Workshop Calendar.

Language and Grammar
The CTPLT offers workshops through the year on aspects of formal, academic expression. There are also weekly ‘Drop In’ Language and Grammar sessions. Information about topics, dates and venues can be found on the Academic Development Workshop Calendar.

School of Arts Workshops
In the Autumn and Spring terms, Dr Fleur Rothschild, Learning Development Tutor for the School of Arts, offers a series of workshops on:

- Study Skills
- Research Skills
- Essay Writing
• Language and Grammar

These workshops are open to all students in the School of Arts, including Postgraduate students, and there is always a contingent of PGs who attend each term. The schedules are usually published in September and can then be accessed via the Birkbeck website here or in the Academic Development Workshop Calendar.

Regrettably, Dr Rothschild is unable to offer one-to-one help to Postgraduate students who should, in the first instance, contact their Personal Tutor, or Dissertation Supervisor.

Online resources

Online resources can be found in students’ Moodle list:

• Birkbeck Learning Skills, for example What materials are available to help develop my academic English?
• School of Arts Study Skills
  Study Tools; Language and Grammar. This resource is a WIP which will be progressively developed through the summer and the coming academic year. It currently contains resources and slides from some of the Study Skills, and Language and Grammar workshops.

Get Ahead: Stay Ahead - Helping you get the best possible start to your course

At Birkbeck we want to make sure you get all the help you need to get your studies off to a great start and to provide you with support during your course. On the Get Ahead: Stay Ahead website you can access a range of online resources to help you:

• consider how you can achieve your goals
• find out what studying at Birkbeck is like
• improve your study skills and succeed on your course
• The online materials are interactive tutorials that are free to use and you can work through them at your own pace.

These interactive tutorials will help you consider how you can achieve your goals, find out what studying at Birkbeck is like and improve your academic skills: http://www.bbk.ac.uk/mybirkbeck/get-ahead-stay-ahead.

For further information on Learning Development and Academic Skills support available within Birkbeck College, please see the website for details: http://www.bbk.ac.uk/mybirkbeck/services/facilities/support.
As a Birkbeck student, you can get access to a range of support and study facilities. Please follow the links below to access current information on the following facilities:

- Academic support
- Accommodation services
- Career services
- Computing and IT services
- Counselling service
- Disability and dyslexia support
- Financial support
- Graduate Research School
- Health services
- Learning Development Service
- Library services
- Lockers
- Moodle
- Nursery
- Orientation for new students
- Student Advice Centre
- Wellbeing Service

If you want to talk to someone about any aspect of this provision, please contact the Student Advice Service.
International Students

Birkbeck offers a range of support services for international students. Please access the website for details here.

- Guide for international students
- Submit your Visa and immigration enquiry
- Visa and registration information
Study Resources

Birkbeck Computer Services
There are two or three large rooms in the main building and one in the basement of Senate House that make computer terminals available to Birkbeck students. This gives you free access to word-processing should you require it, as well as an email account and entry to the internet. There are many, constantly growing resources available on the Internet, and it is becoming an increasingly vital element of academic research. Please see details on the website here: http://www.bbk.ac.uk/its/timetables/.

The College constantly runs a rotating series of courses introducing students to word processing packages, negotiating the Internet, and other skills: check the notice board outside E101 (meaning the first floor of the extension block of the main building), and sign up early: these courses are very popular.

College Hardship / Book Buying Funds
It may be possible, if you are having financial difficulties, to apply to the College for assistance with fees and to receive small awards to help with the purchase of essential texts. For information and advice, contact the Student Advice Service and see the Birkbeck website here for further details: http://www.bbk.ac.uk/student-services/financial-support/hardship-fund.

Libraries

Birkbeck Library

Birkbeck Library is on the first floor of the main building in Malet Street. Please refer to the Birkbeck website for current User Information, Library Opening Hours, Frequently Asked Questions, and to search the online catalogue.

Birkbeck Electronic Library
The Library subscribes to many electronic journals and databases. You can access these from anywhere within College using your Central Computing Services (CCS) username and password, and the majority of these resources can also be accessed from home or work. As well as finding comprehensive information about the Library, its services and collections, you can also:

- Search the Library catalogue, renew your books and place reservations on items out on loan.
- Read articles in over 12,000 electronic journal titles and newspapers.
- Search databases to help you find out what has been written about the subject you are researching, including Literature Online (LION), which includes the MLA
International Bibliography (MLA) and the Annual Bibliography of English Language and Literature (ABELL), the Arts & Humanities Citation Index, JSTOR, PCI and Project Muse.

- Work through LIFE – an online tutorial to help you make the most of the Library.

**Other libraries**

Birkbeck students can also use a range of other libraries. Students have reference access to most University of London college libraries. In addition, the UK Libraries Plus Scheme allows students reference access to over 135 other higher education libraries and part-time students may also borrow from up to three member libraries. See the Library web site for more information.

**Further information and help**

Please contact your **Subject Librarians** for MA Contemporary Literature and Culture programme on [c.hobson@bbk.ac.uk](mailto:c.hobson@bbk.ac.uk). Feel welcome to contact them with any Library enquiries.

**Senate House Library**

Situated next door to Birkbeck College, on the fourth floor of Senate House, this is a world-class research library, with extensive collections in twentieth-century British and American fiction and criticism. Staff are very helpful in negotiating this initially confusing library, and you should be able to find most of the materials you require. They have recently purchased a large number of videos which can be viewed in the building. Membership of this library is absolutely vital for your MA. **How to join:** go to Senate House Library with your Birkbeck ID card and your Certificate of Birkbeck Student Eligibility (which you can access via [My Birkbeck - go to the Student Library Services' section, choose 'My Senate House Library access'](https://my.bbk.ac.uk) - you can take a hard copy or show it on your mobile device.

**British Library**

A copyright library, which receives all books published in Britain and has a very broad and deep collection of books published elsewhere too. It is only 15 minutes walk from Birkbeck and is an excellent resource for MA study. Books usually take between 50 minutes and 2 hours to arrive at your desk. The library has changed its policy regarding student admission several times in the past year. At the time of going to press, you should be able to join on showing your MA card, but it is worth checking the website for details before you visit for the first time. Queues to the admissions office tend to build up in the middle of the day – try first thing in the morning (from 9:30 am, or 10:00 am on Mondays). The library is open until 8:00 Monday-Thursday, and until 5 on Fridays and Saturdays.

**University College Library**

This is situated 5 minutes away from Birkbeck, on Gower Street. Students from
Birkbeck are admitted to the library, and since it has extensive holdings in English literature, it is worth holding in reserve if texts are proving difficult to obtain. Make sure you have your Birkbeck college card and a photograph when you first visit.

**M25 Consortium Libraries and SCONUL Research Extra**

Birkbeck participates in an arrangement that allows academics and research students to use other research libraries in the country. It may be convenient for you to have access to the libraries of another university, especially if you do not live or work close to Birkbeck. Some university libraries also have extended hours, which can be useful if you need a quiet place to work later at night. (Imperial, for example, is open for 24 hours during its exam period, including to registered external users.) Opening hours change with some regularity, and libraries have different kinds of restrictions, so check websites for details. Begin with the M25 Consortium Libraries page at www.m25lib.ac.uk/; and www.sconul.ac.uk/use_lib/srx/.

**Senate House Library**

Senate House  
Malet Street  
London WC1E 7HU  
Telephone: 020 7862 8500  
Fax: 020 7862 8480  
Website: www.senatehouselibrary.ac.uk  
Nearest Tube: Goodge Street or Russell Square

**Birkbeck College Library**

Malet Street  
London WC1E 7HU  
Telephone: 020 7631 6239  
Website: http://www.bbk.ac.uk/lib/  
Nearest Tube: Goodge Street or Russell Square

**Little Magazines Library**

Little Magazines Department  
The Library  
University College London  
Gower Street  
London WC1E 6BT  
Telephone: 020 7380 7796 (direct line) or: 020 7387 7050 ext 7796  
Fax: 020 7380 7727  
Website: https://www.ucl.ac.uk/library/special-collections/a-z/little-mags  
Nearest Tube: Goodge Street

**Courtauld Institute of Art Library**

Somerset House
Strand
London WC2R 0RN
Telephone: 020 7873 2649
Fax: 020 7873 2410
Website: https://courtauld.ac.uk/study/resources/book-library
Nearest Tube: Charing Cross

School of Oriental and African Studies Library
Thornhaugh Street
Russell Square
London WC1H 0XG
Telephone: 020 7323 6109
Fax: 020 7636 2834
Website: http://www.soas.ac.uk/Library/
Nearest Tube: Goodge Street or Russell Square

School of Slavonic and East European Studies Library
Senate House
Malet Street
London WC1E 7HU
Telephone: 020 7862 8523
Fax: 020 7862 8644
Website: https://www.ucl.ac.uk/ssees/library
Nearest Tube: Goodge Street or Russell Square

University of London Institute of Education Library
20 Bedford Way
London WC1H 0AI
Telephone: 0207 612 6000
Website: http://www.ioe.ac.uk/infoserv/ishome.htm
Email: lib.enquiries@ioe.ac.uk
Nearest Tube: Russell Square

University of London Institute of Historical Research Library
Senate House
Malet Street
London WC1E 7HU
Telephone: 020 7862 8740
Website: http://ihr.sas.ac.uk/cwis/library.html
Email: ihr@sas.ac.uk
Nearest Tube: Goodge Street or Russell Square

Warburg Institute Library
Woburn Square
London WC1H OAB
Telephone: 020 7862 8949
Fax: 020 7862 8939
Website: https://warburg.sas.ac.uk/library-collections/library
Nearest Tube: Russell Square

British Library: Humanities and Social Sciences
96 Euston Road
St Pancras
London WC1E 7HU
Telephone: 020 7412 7676 (reading room); 020 7412 7677 (membership enquiries)
Website: http://www.bl.uk/
Nearest Tube: Euston or Kings Cross

British Library Newspaper Library
Colindale Avenue
London NW9 5HE
Telephone: 020 7412 7353
Fax: 020 7412 7379
Website: http://www.bl.uk/collections/newspapers.html
Nearest Tube: Colindale

Daily and weekly newspapers and periodicals, including London newspapers and journals from 1801, English provincial, Welsh, Scottish and Irish newspapers from about 1700, and collections of Commonwealth and foreign newspapers.

British Library National Sound Archive
96 Euston Road
London NW1 2DB
Telephone: 020 7412 7440
Fax: 020 7412 7441
Website: https://www.bl.uk/subjects/sound
Nearest Tube: Euston or King’s Cross

Music recordings of most periods, styles and countries; oral history, spoken literature and drama; wildlife sounds and sound effects. Duplicate recordings of BBC material. Free public listening service by appointment.

British Library Asia, Pacific and Africa Collections
96 Euston Road
London NW1 2DB
Telephone: 020 7412 7873
Fax: 020 7412 7641
Website: http://www.bl.uk/onlinegallery/onlineex/apac/
Nearest Tube: Euston or King’s Cross
The National Archives
Ruskin Avenue
Kew
Richmond
Surrey TW9 4DU
Telephone: 020 8392 5200
Fax: 020 8392 5286
Website: http://www.nationalarchives.gov.uk/
Nearest Tube: Kew

Guildhall Library
Aldermanbury
London, EC2P 2EJ
Telephone: 020 7332 1868 or 1870
Website:
https://www.cityoflondon.gov.uk/things-to-do/guildhall-library/Pages/default.aspx
Nearest Tube: St Paul's, Bank or Moorgate

History and topography of London. Publications of national and local historical societies, newspapers, complete files of House of Commons and Lords debates and journals, large collections of public and local acts and statutory instruments, House of Commons papers complete from 1830.

Barbican Library
Barbican Centre
London, EC2Y 8D5
Telephone: 020 7638 0569
Website: https://www.barbican.org.uk/your-visit/during-your-visit/library
Nearest Tube: Barbican, Moorgate, St Paul’s.

St Bride Printing Library
Bride Lane
Fleet Street
London, EC4Y 5EE
Telephone: 020 7353 4660
Website: https://www.sbf.org.uk/
Nearest Tube: Blackfriars or St Paul’s

Printing, publishing, graphic design and related subjects. Early technical manuals, manufacturers’ prospectuses and type specimens. Trade serials and directories.

Battersea Reference Library
Altenburg Gardens
Lavender Hill
Occult, architecture, William Blake, G A Henty, Edward Thomas. Closed some days - it’s advisable to ring to check opening hours before visiting.

West Hill Reference Library
West Hill, (corner of Santos Road)
London SW18 1RZ
Telephone: 020 871 6386
Fax: 020 7978 4376
Website: http://www.wandsworth.gov.uk/Home/LeisureandTourism/Libraries/Details.htm#westhill
Nearest Tube: East Putney

Humanities, fine arts, special loan collections on history and travel. Closed some days – it’s advisable to ring to check opening hours before visiting.

Marylebone Library
109-117 Marylebone Road
London NW1 5PS
Telephone: 020 7641 1037
Fax: 020 7641 1044
Website: https://www.westminster.gov.uk/library-opening-hours-and-contact-details
Nearest Tube: Baker Street or Marylebone

Medical collection, including dentistry and nursing. Also the Sherlock Holmes Collection which contains material relating to Conan Doyle and the history of detective fiction, and can be seen by appointment only.

Specialist Libraries Open to the Public:

Commonwealth Resource Centre
Commonwealth Institute
Kensington High Street
London W8 6NQ
Telephone: 020 7603 4535 ext. 210
Fax: 020 7603 2807
Website: http://www.commonwealth.org.uk/
Nearest Tube: High Street Kensington
The Commonwealth Literature Library has a unique collection of 11,000 books, written and translated into English on all aspects of Commonwealth and postcolonial literature. The Commonwealth Resource Centre provides multi-media resources for loan and information on all 54 member countries, peoples and organisations making up the contemporary Commonwealth community.

**The Women's Library**

LSE Library  
10 Portugal Street  
London WC2A 2HD  
Telephone: 020 7405 7686  
Website: [http://www.lse.ac.uk/Library/Collections/Collection-highlights/The-Womens-Library](http://www.lse.ac.uk/Library/Collections/Collection-highlights/The-Womens-Library)  
Nearest Tube: Holborn

Women’s history, fiction, poetry, magazines; feminism and feminist criticism. The UK’s best resource for women’s history and literature.

**The Great Britain - China Centre Library**

15 Belgrave Square  
London SW1X BPS  
Telephone: 020 7235-6696  
Fax: 020 7245-6885  
Website: [http://www.qbcc.org.uk/](http://www.qbcc.org.uk/)  
Nearest Tube: Hyde Park, Knightsbridge or Victoria

**Imperial War Museum (School of Printed Books)**

Imperial War Museum  
Lambeth Road  
London SE1 6HZ  
Telephone: 020 7416 5342  
Fax: 020 7416 5374  
Website: [http://london.iwm.org.uk/](http://london.iwm.org.uk/)  
Nearest Tube: Lambeth North

History of the two world wars, and other wars and military undertakings involving Britain and the Commonwealth since 1914.

**Poetry Library**

Level 5  
Royal Festival Hall  
South Bank Centre  
London SE1 8XX  
Website: [http://www.poetrylibrary.org.uk/](http://www.poetrylibrary.org.uk/)
Nearest Tube: Waterloo or Embankment

The Wellcome Institute for the History of Medicine Library
The Wellcome Building
183 Euston Road
London NW1 2BE
Telephone: 020 7611 8582
Fax: 020 7611 8369
Website: [http://wellcomelibrary.org/](http://wellcomelibrary.org/)
Nearest Tube: Euston or Euston Square

Websites giving UK libraries information
COPAC
[http://www.copac.ac.uk/copac/](http://www.copac.ac.uk/copac/)
Access to the catalogues of all major UK university libraries. If you can’t get the book you need in London, see if you can find it here and ask Birkbeck Library to arrange an inter-library loan.

M25 Consortium
Links to over 100 libraries in the London area

UK Public Libraries
[https://librarytechnology.org/libraries/ukpublic/](https://librarytechnology.org/libraries/ukpublic/)

Libraries Information (via Birkbeck)
[http://www.bbk.ac.uk/lib/otherlibs/other-libraries](http://www.bbk.ac.uk/lib/otherlibs/other-libraries)
Other Graduate Activities

We have a large postgraduate community, and there are many other arenas you might wish to participate in. We circulate information by email about interesting and relevant events taking place in London and beyond: conferences, readings, exhibitions.

**The Birkbeck Centre for Contemporary Literature (CCL)**
Founded in 2012, [Birkbeck's Centre for Contemporary Literature](#) is a meeting place for numerous ongoing projects by academic staff, creative writers and graduate students. The Centre hosts conferences and symposia, readings and seminars on a range of contemporary writers – in prose fiction but also potentially in other forms and media. We are open to suggestions for future projects and events, including collaborations with other departments, writers and artists, and non-academic institutions.

**Centres for Poetics and Cinema**
Dr Stephen Willey directs the [Centre for Poetics and Cinema](#) which runs seminars, workshops, conferences and readings by poets throughout the year, and also collaborates on writing projects such as the Voiceworks series with the Wigmore Hall and Guildhall School of Music. The Centre has its own web journals, *pores* and *Readings*, and has developed an imprint, Veer Books, along with an active group of postgraduate poets, London Under Construction. Sessions are open and informal. Look out for regular posts on email.

**Birkbeck day conferences**

**The Centre for English Studies**
The Centre for English Studies is located on the third floor of Senate House, and provides a structured sequence of seminars, lectures from distinguished speakers, day conferences and graduate seminars. Many of these are held during the day, but there are also weekend conferences and late afternoon meetings if you are able to attend. The Centre releases a batch of material at the beginning of each term, announcing the programme for the coming weeks: we will normally email you about relevant events.
Look out particularly for the **London Modernism Seminar** which meets on the first Saturday of each month during term time.

The **Institute for Romance Studies**, also located in Senate House, often puts on lectures and conferences which may be relevant to your studies. Information is available at Senate House, and also advertised on the notice-board.

**Research Centres**
Birkbeck, University of London, is an internationally recognised institution with a reputation for cutting-edge research. The School of Arts brings together some of the finest research activity across the college, research that is recognised as world-leading.

Research in our School is conducted under the auspices of our academic departments as well as our highly respected research centres. You are warmly encouraged to engage with the various research centres throughout the School, and wider college, to attend and get involved in organizing events to better inform your own research and study.

The School’s Research Centres can be found here: [http://www.bbk.ac.uk/arts/research/research-centres](http://www.bbk.ac.uk/arts/research/research-centres)
Appendix A: Getting Started with Moodle

What is Moodle?
Birkbeck uses 'Moodle' as its Virtual Learning Environment (VLE) platform. Moodle is used to house course documentation (handbooks, module outlines, coursework, coversheets etc.) materials (readings, PowerPoint presentations, slide lists etc.) and for electronic submission and marking of coursework.

Access Moodle
You can access Moodle here. To log in you need your ITS username and password, a computer with a connection to the internet and a web browser such as Internet Explorer or Firefox.

Login Details
If you are having login problems, but your password is working for other services, please change your password via the online form (allow one hour after completing this form, and then log in to Moodle again). If this hasn't resolved the problem please contact the ITS Helpdesk via ASK Query telephone (020 3926 3456), or in person (Malet St building, next to the entrance to the Library).

Moodle Support for Students
Please access the Moodle Support area for Birkbeck students for information on how to get started with Moodle and updates on how to submit the all-important Turnitin assignment.
Appendix B: Common Awards Scheme Regulations and Policies

Common Awards Scheme
Please access the Common Awards Scheme regulations for taught and research programmes for the current academic year.

If you have any queries regarding the regulations please contact asq@bbk.ac.uk.

Policies
See the Birkbeck College website for access to current policies including: Assessment Offences, Mitigating Circumstances and Break-in-Studies Policy.
Appendix C: MA Dissertation Proposal Form

Name:
Student Number:

Proposed Topic:

Brief Outline / Abstract:

Overview of how the creative and critical components will work together: